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Аннотация

Методическая разработка «Знакомство с редактором Visual Studio Code» по МДК.01.01 Разработка программных модулей предназначена для студентов специальности 09.02.07 Информационные системы и программирование разработана в соответствии с рабочей программой МДК.01.01 Разработка программных модулей. 
Методическая разработка содержит:
- теоретические сведения по теме «Что такое Visual Studio Code?»; 
- практические задания по теме, которые носят и репродуктивный, и частично-поисковый характер; 
- задания для самостоятельной работы, которые позволяют закрепить навыки работы учащихся; 
- перечень использованных источников.
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Введение

Язык HTML (Hyper Text Markup Language) предназначен для оформления документов в Internet. Это не язык программирования и не алгоритмический язык. HTML является интерпретируемым языком, поэтому при обнаружении в тексте ошибки на экран выводится соответствующее предупреждение, а строка с ошибкой игнорируется. Зарождение HTML началось в 1986 г., когда впервые усилиями Международной организации по стандартизации (ISO) был принят ISO-8879 – стандарт, названный ими «Standard Generalized Markup Language» (SGML). Данный язык описывался как язык для структурной (логической) разметки текста.
Любая веб-страница представляет собой простой текст, написанный на языке html.
Процесс создания документов может быть разделен на две стадии: 
- получение простого исходного текста (непосредственно вводом с клавиатуры, сканированием, копированием из другого файла и т.д.);
- последующее форматирование с разбивкой текста на абзацы, установка нужных шрифтов, выделение списков, вставка таблиц и рисунков и т. д. 
Теоретически писать код можно в простом текстовом редакторе. Но лучше использовать специальные программы, например, Visual Studio Code. 
[bookmark: _Toc30579255]

Основная часть

Visual Studio Code (VS Code) — это редактор исходного кода. Его разработал Microsoft для всех популярных операционных систем: Windows, Linux и macOS.
У Visual Studio Code есть особенности, которые отличают его от других визуальных редакторов кода:
· Можно скачать и использовать без оплаты лицензии.
· Для VS Code есть расширения, которые позволяют подстраивать его под конкретные задачи.
· Весит немного и запускается даже на не очень мощных компьютерах, при этом обладает всем нужным функционалом.
· Подходит для кроссплатформенной разработки, позволяет писать код на разных языках для облачных и веб-приложений.
· Простота в освоении: начать работать можно сразу после установки, а потом постепенно открывать для себя новые функции, чтобы больше автоматизировать работу.

Как установить Visual Studio Code на Windows

1. Скачать программу для установки.
2. Запустить установщик и следовать инструкциям. Здесь всё стандартно, как с установкой любой программы: выбираете папку и устанавливаете.

Интерфейс программы

Интерфейс VS Code во многом похож на интерфейс MS Word или Photoshop: меню с выпадающими списками вверху, инструменты для работы — слева, рабочая область — справа. 
[image: Так выглядит интерфейс VS Code с уже открытым рабочим проектом] 
Интерфейс на английском, и лучше всего таким его оставить: если будете искать в интернете решение каких-то проблем, оно, скорее всего, будет описано именно на английском. 
Блоку с кодом отведено больше всего места. Как и в других редакторах, в VS Code здесь есть подсветка синтаксиса — функции, команды и переменные выделены разным цветом.
[image: https://avatars.mds.yandex.net/get-lpc/403342/cc95d2ad-be9b-4cc7-a9d3-4ea007fd5eb4/width_1280_q70]
Над блоком с кодом расположено меню с вкладками. Там лежат другие открытые файлы, чтобы между ними можно было быстро переключаться. Это нужно, чтобы работать в Visual Studio Code над проектами с несколькими файлами. 
[image: https://avatars.mds.yandex.net/get-lpc/1364677/cac215ff-42d7-41a8-9f91-2300c5edba7d/width_1280_q70]
В самой левой части экрана VS Code находится панель управления. 
[image: В самой левой части экрана VS Code находится панель управления]
Верхние пять элементов — основные:
· Проводник — чтобы быстро перемещаться между файлами внутри проекта.
· Поиск — для поиска конкретных слов внутри документа. Например, он позволяет найти переменную везде, где она используется.
· Система управления версиями — предназначена для взаимодействия с Git, просмотра изменений в коде и разных его версий.
· Запуск кода — позволяет запустить и проверить код на работоспособность.
· Расширения — каталог расширений, которые можно установить для добавления в VS Code дополнительного функционала.
Другие элементы меняются в зависимости от того, какие расширения установлены. Например, Docker для работы с контейнеризацией кода или Jupyter для тех, кто хочет заниматься Data Science и открывать нужные для этого файлы прямо в VS Code.
При нажатии на одну из иконок между левой панелью и окном с кодом открывается небольшое окно с возможностями этого элемента управления.
[image: https://avatars.mds.yandex.net/get-lpc/403342/57496a84-9727-43e0-a8c8-335089924f27/width_1280_q70]
В самой нижней части интерфейса находится статус-бар. 
[image: https://avatars.mds.yandex.net/get-lpc/1220100/bd9d15f5-f940-453e-a755-b023b67d4808/width_1280_q70]
В нём VS Code показывает общую информацию о состоянии программы: обнаруженные ошибки, количество строк, язык программирования. Всё это он считает автоматически.
[image: https://avatars.mds.yandex.net/get-lpc/1520633/b19fe633-df39-4e79-83cd-ca312e6166cf/width_1280_q70]
Настройка Visual Studio Code

Открыть графический редактор настроек можно сочетанием клавиш «Ctrl+», либо пройдя по пути «File → Preferences → Settings». 
Теперь можно выбирать разные категории параметров и настраивать их вручную. Чтобы не переключаться по всем вкладкам, нужные параметры для настройки можно вбивать в строку поиска.
 У VS Code есть ряд полезных настроек для автоматизации рабочего процесса:
· Автосохранение. Найдите параметр Files: Auto Save. Измените значение с «Off» на «afterDelay», задайте промежуток времени — и файлы будут автоматически сохраняться в заданный промежуток.
· Размер шрифта. Параметр Font Size. По умолчанию 14, можно изменить на удобный.
· Форматирование кода. Параметр Format On Paste. Код будет автоматически форматироваться при вставке. Позволяет исправить проблемы с лишними отступами.
· Удаление конечных пробелов. Параметр Trim Trailing Whitespace. При сохранении из документа автоматически удаляются пробелы в конце строк. Это нужно, чтобы не перегружать код лишними символами и проходить некоторые проверки на стиль кода.
Некоторые изменения в программе нужно задавать не через меню настроек, а через расширения. Например, если очень хочется русифицировать VS Code, нужно открыть вкладку с расширениями, ввести запрос vscode-language-pack-ru и нажать кнопку «Install». После этого язык интерфейса изменится на русский. 
Можно изменить цвет интерфейса. Для этого нужно нажать «CTRL+SHIFT+P», ввести запрос «theme» и выбрать «Preferences: Color Theme». Там откроется список тем, между которыми можно выбирать.

Задание.
	1. 
	 Установить программу Visual Studio Code.
Скачать VS Code по ссылкам:
https://code.visualstudio.com/download
https://visualstudio.microsoft.com/ru/downloads/

	2. 
	Запустить программу Visual Studio Code 
Выполнить создание нового файла, выполнив команду File=>New File


	3. 
	Результат 

	4. 
	Выполнить сохранение файла, дав ему имя и указав тип файла HTML

1.HTML
	

	5. 
	На первой строке файла ввести восклицательный знак и нажать клавишу Tab


Результат
Таким способом вводиться шаблон кода (основу), определяющий структуру сайта
	


	6. 
	· Выполнить смену языка веб-страницы

· Ввести заголовок окна
· Ввести содержимое страницы
· Сохранить файл командой File => Save
	

	7. 
	Загрузить готовый файл в браузер
	

	8. 
	· Выполнить создание нового файла 2.HTML
· Создать основу страницы
· Сменить язык
· Заголовок Рыбный текст
· Содержимое сайта: 
ввести слово Lorem и нажать клавишу Tab (можно ввести Lorem200/LoremN), где N число, указывающее количество слов
· Сохранить файл
	
Команда меню View => Word Wrap выполнит перенос по словам в окне редактора кода

	9. 
	Загрузить готовый файл в браузер
	

	10. 
	Выполнить создание нового файла 3.HTML

Тег <h1>  - Парный тег устанавливает заголовок первого уровня

	11. 
	Загрузить готовый файл в браузер
	

	12. 
	Выполнить редактирование файла 3.HTML

Вести теги:
· <hr> одиночный тег черты
· <br> одиночный тег переноса на новую строку
· <p> Абзац </p> парный тег параграфа
	

	13. 
	Результат
 По необходимости обновите страницу браузера



Запомнить:
· Основа страницы, нажатие клавиш: ! +Tab 
· Заголовок окна <title> Заголовок </title>
· <body> Содержимое страницы </body> - тело документа
· Рыбный текст LoremN + Tab, где N число, указывающее количество слов
· <h1>Заголовок 1 </h1>  – Парный тег устанавливает заголовок первого уровня
· <hr> – одиночный тег черты
· <br> – одиночный тег переноса на новую строку
· <p> Абзац </p> – парный тег параграфа


Задания для самостоятельной работы
	14. 
	Смена языка Visual Studio Code (по необходимости)
· Запустить программу Visual Studio Code ;
· Нажать кнопку Extensions и найти «Языковый пакет для русского языка для VS Code»;
 
· Выполнить установку пакета (нажать кнопку Install);

· Закрыть программу Visual Studio Code и вновь открыть.


	15. 
	· Создать новый файл и сохранить его в папку (Урок2);
· Создать файл по образцу, использовать комментарий и тег <pre> </pre> (пользовательское форматирование);

· Для создания комментария выполнить команду Правка => Переключить комментарий строки (также можно использовать клавиши Ctrl + /);


	16. 
	Создать новый файл, используя тег <i></i>


Проверить файл в браузере
	


	17. 
	Создать новый файл, используя тег <em></em>


Проверить файл в браузере
	


	18. 
	Создать новый файл, используя тег <b></b>


Проверить файл в браузере
	


	19. 
	Создать новый файл, используя тег <strong> </strong>


Проверить файл в браузере
	


	20. 
	Создать новый файл, используя тег <mark> </mark>


Проверить файл в браузере
	


	21. 
	Создать новый файл, используя тег <small> </small>





Проверить файл в браузере
	


	22. 
	Создать новый файл, используя тег <s> </s>





Проверить файл в браузере
	


	23. 
	Создать новый файл, используя тег <u> </u>



Проверить файл в браузере
	


	24. 
	Создать новый файл, используя тег <sub> </sub>




Проверить файл в браузере
	


	25. 
	Создать новый файл, используя тег <sup> </sup>



Проверить файл в браузере
	


	26. 
	Создать новый файл, используя тег <ins> 
</ins >



Проверить файл в браузере
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[bookmark: _Toc30579256]Заключение
                
Visual Studio Code — это бесплатный и универсальный редактор кода, который поддерживает различные языки программирования и обладает широким набором расширений для удобной работы программистов. 
Визуальный редактор кода позволяет:
· Работать с IntelliSense — автоматическим дописыванием функций при вводе первых букв.
· Выполнять отладку — искать и устранять ошибки в написанном коде.
· Удобно писать код — автоматически заполнять нужную информацию, подсвечивать элементы синтаксиса в зависимости от выбранного языка, расставлять нужные отступы.
· Контролировать версии кода, в том числе с помощью системы управления версиями Git.
· Рефакторить код для улучшения его работы и читабельности.
Все эти функции значительно облегчают труд разработчика: позволяют избежать опечаток, реже ошибаться и работать быстрее.
[bookmark: _Toc30579257]
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from utils.wrappers inport JobWithMessage

def _build_preprocessor(
preprocessor_slug: str,
whoargs,

) => preprocessors_nodule. BasePreprocessor:
Class_obj = PREPROCESSOR_SLUG_TO_CLASS [preprocessor_slug]
return class_obj (preprocessor_slug, %+kwargs)

def build_preprocessors(
preprocessor_slugs: tp.List(strl,
wkiargs,
) -> tp.Optional [tp.List[preprocessors_module.BasePrepracessor]]:
if not preprocessor_slugs:
return None
return [_build_preprocessor(slug, #ekwargs) for slug in preprocessor_slugs]

def build_data_module(
dataset_nane: str,
path_to_train: str,
path_to_val: str,
path_to_test: str,
batch_size: int,
preprocessors: tp.0ptionaltp.List [preprocessors_module, BasePreprocessorl],

Loader_class = DATASET_TO_MODULE [dataset_name] [ Loader"]

target_extractor_class = DATASET_TO_MODULE [dataset_name] ["target_extractor"]
event_loader: base_event_loader. BaseEventLoader = loader_class()
target_extractor: preprocessors_nodule.BasePreprocessor = target_extractor_class()

train_events = event_loader (path_to_train)
val_events = event_loader (path_to_val)
test_events = event_loader (path_to_test)

return event_log_data_nodule. EventLogbataodule(
train_event_log=train_events,

test_event_log=test_events,

target_extractors=|target_extractor],
preprocessors=preprocessors,

@ pipeline.py X
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from utils.wrappers inport JobithMessage

def _build_preprocessor(
preprocessor_slug: str,
wkoargs,

) => preprocessors_nodule. BasePreprocessor:
class_obj = PREPROCESSOR_SLUG_TO_CLASS [preprocessor_slug]
return class_obj (preprocessor_slug, *skwargs)

def build_preprocessors(
preprocessor_slugs: tp.List(str],
koargs,
) => tp.Optionalltp.List [preprocessors_module.BasePreprocessor]]:
if not preprocessor_slugs:
return None
return [_build_preprocessor(slug, #+kwargs) for slug in preprocessor_slugs]

def build_data_nodule(
dataset_nane: str,
path_to_train: str,
path_to_val: str,
path_to_test: str,
batch_size: int,
preprocessars: tp.0ptional[tp.List [preprocessors_module. BasePreprocessorl],
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4 <title> Ter <small></title>

5 </head>
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7 <div>
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